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Introduction

There are two main types of testing necessary for an application such as VStar:
unit testing and system testing.

Unit Testing

VStar contains a set of so-called unit tests that can be run via ant test (see
build.xml atthe top-level of the VStar distribution available from
SourceForge:
http://vstar.svn.sourceforge.net/viewvc/vstar/trunk/test/?pathrev=671) to
determine whether key modules (Java classes) and functionality work and
continue to work over time in the face of changes to the code base. The ability to
perform such regression testing provides some confidence in the health of VStar’s
code base and allows the code to be modified without fear. If a unit test fails after
a change is made, the test itself can help to debug the cause of the problem.

There are many more unit tests that could be written to improve code coverage,
and anyone interested in writing unit tests for VStar should put their hand up.

System Testing

As important as unit testing is, it is no substitute for GUI or system testing. In the
case of VStar, this is something that has been done in a very ad hoc way, usually
just before a release.

The strategy in future releases is to first make a WebStart release available to the
Citizen Sky VStar Software Development Team. After a period of system testing



by team members, the version will be deployed to the broader AAVSO
community.

The focus of this document is to set out some system testing scenarios. For a new
version of VStar, please choose one or more scenarios and test VStar against it,
reporting any problems you find to the Citizen Sky VStar Team forum or to me
(dbenn@computer.org). The forum is better, especially if more than one person
finds the same bug.

Some scenarios make use of 5 star analysis tutorial data files (hereafter referred
to as “5-star file”. You can obtain 5star-data-files.zip from SourceForge:
https://sourceforge.net/projects/vstar/files/

The test scenarios are, to some extent, meant only as guides. [ would recommend
initially following them mechanically, later coming up with your own variations.
There is value in simple repetition, from a regression viewpoint, i.e. to answer
the question: has anything broken/changed/been fixed since the last time I did
this?

If you would like to contribute scenarios to this document, please do so either via
the Citizen Sky VStar Team forum or via email.

Of course, you should also carry out any other kind of testing you desire. Try to
break VStar! The change log:

http://vstar.svn.sourceforge.net/viewvc/vstar/trunk/ChangeLog.txt?revi
sion=671&view=markup&pathrev=671

is updated for each release, and provides a good indication of new features and
bug fixes that need testing over and above the scenarios below.

Scenario: General Tour
This scenario takes a broad approach to testing key VStar features.

1. SelectNew Star from File from the File menu or toolbar.
2. Open the 5-star file Ix_cyg_2439800_2447500.csv

3. Select Information from the File menu or toolbar. The opened dialog
should look like this:



8.N6 Information

Summary

Object: Ix_cyg_2439800_2447500.csv
Loaded Observations: 473

Series

Visual: 400
Fainter Than: 57
Discrepant: 16

4. Selectthe Mean Plot tab.UnselectError bars? and Join means?
check-boxes. The mean plot should look like this:
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Light Curve with Means for Ix_cyg_2439800_2447500.csv
Mean error bars denote 95% Confidence Interval (twice Standard Error)
F-value: 31.59 on 160 and 239 degrees of freedom, p-value: < 0.000001
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'Ix_cyg_2439800_2447500.csv' loaded.

5. Select the Observation List tab. Select the row whose Julian Day is 2440130.6.
This is what you should see:
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[ Observation Plot  Mean Plot  Observation List | Mean List |
Julian Day Calendar... Magnitude Band Observer... Validation Comp Star 1 Comp Star 2 Charts Comment... Comments Transform... Airmass CMag KN
2439818.6 1967 NO... 12.2 Visual FD Good no s
2439826.6 1967 DEC211.8 Visual FD Good no m
2439838.5 1967 DEC... 11.0 Visual LS Good no
2439844.6 1967 DEC... 10.9 Visual Ls Good no
2439845.6 1967 DEC... 10.6 Visual FD Good no
2439851.7 1967 DEC... 10.6 Visual CR Good no
2439854.5 1967 DEC... 10.4 Visual T Good no
2439874.5 1968 JAN... 10.9 Visual LS Good no
2439877.5 1968 JAN... 10.3 Visual FD Good no
2439903.5 1968 FEB... 11.1 Visual LS Good no
2439965.8 1968 APR... 13.3 Visual FD Good no
2440031.8 1968 JUN... 13.0 Visual FD Good no
2440036.8 1968 JUN... 13.1 Visual CR Good no
2440038.8 1968 JuL1 12.8 Visual AC Good no
2440039.8 1968 JuL2 11.2 Visual AD Discrepant no
2440056.8 1968 JuL... 13.1 Visual CR Good no
2440058.6 1968 JuL... 12.7 Visual LS Good no
2440066.7 1968 JUL... <13.7 Visual SCE Good no
2440077.6 1968 AU... 13.1 Visual FD Good no
2440089.7 1968 AU... <14.5 Visual T Good no
2440097.9 1968 AU... 16.2 Visual CE Discrepant no
2440097.9 1968 AU... <16.0 Visual FD Good no
2440126.8 1968 SEP... 12.9 Visual HR Good no
2440126.9 1968 SEP... 12.9 Visual CR Good no
2440127 6 1968 SEP.. <14 0 Vlsual
_________l
2440134 7 1968 oC... <13 7 Vlsual
2440145.7 1968 OC... 12.9 Visual Ij Good no
2440153.7 1968 OC... 13.5 Visual FD Good no
2440154.8 1968 OC... 13.5 Visual CR Good no
2440181.6 1968 NO... 13.4 Visual SCE Good no
2440209.6 1968 DEC...12.7 Visual FD Good no
2440220.6 1968 DEC...12.5 Visual CR Good no
2440230.5 1969 JAN 9 14.0 Visual FD Good no
2440334.9 1969 APR... 10.6 Visual AC Good no
2440338.9 1969 APR... 10.6 Visual HR Good no Y
2440347.8 1969 MA... 10.3 Visual FD Good no E
2440382 R_19A9 ILIN 1058 Visual FD Cood non B b4
[ &= —) <]
'Ix_cyg_2439800_2447500.csv' loaded.

Notice that the observation details and zoom toolbar buttons and View menu
items are now active but were not before the selection.

Select the Observation Plot tab. The cross-hair should be on the
observation whose Julian Day is 2440130.6, as follows:
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'Ix_cyg_2439800_2447500.csv' loaded.

8. Select the Observation
dialog should look like this:

9. Close this dialog, then:

Details View menu item or toolbar button. The

O O Details

LX CYG

Julian Date: 2440130.6
Calendar Date: 1968 OCT 1
Magnitude: 13.4
Validation: Good
Band: Visual
Observer Code: FD
Comment Codes:
Comparison Star 1:
Comparison Star 2:
CMag:

KMag:

[} Discrepant?




* Select another data point in the Observation Plot by clicking once with
the mouse elsewhere on the plot.

* Compare the result of opening the Observation Details dialog
via this view and via the Observation List tab; they should be

identical. Hint: you can have multiple Observation Details dialogs open
at once.

* (Check that the selected row in the Observation List contains
information that is consistent with the data point selected in the
Observation Plot view.

10. Carry out similar operations using the Mean Plot and Mean List views.

11. Select the Observation Plot view and select a data point somewhere
near the middle.

¢ Use the toolbar zoom buttons to zoom in a few steps, then back out
again.

* Zoom in a few steps and use the left, right, up, and down pan arrow
keys to ensure you can view parts of the plot “hidden” by the zoom
operation.

12. Open the filter dialog via the toolbar “binoculars” button or the View menu
item. Select an observer code matcher and select the “Use selected
observation?” checkbox. Depending upon which star the cross hairs are on,
the filter dialog should look like this, possibly with a different observer code:

2 3 Filter Observations

L’J

Observer Code ?] equal to SHS

:J
<_>J

:J
<_>J

:J
:J

:J
<_.J

! Use selected observation Reset

~ Cancel ( ok )

13. Click the OK button. A new series should appear, showing all data points
made by the observer corresponding to the data point under the cross hair.



14. Click the Change Series button near the bottom of the Observation
Plot view, deselecting all but the Fi1tered series, so that only the filtered
observations appear, like this:

™ O Change Series

Visibility
[ Visual
[ Fainter Than
(] Discrepant
™ Filtered
(" Select All ) ( Deselect All )
(_Cancel )

15. Open the filter dialog again and add another matcher, such as magnitude, and
an operator such as “less than”:

(S NON) Filter Observations

[ Observer Code F] ( equal to ﬂ SHS

| Magnitude 4] | less than 3] (124

( ol ( m

( s ( E]

« b= | )

M Use selected observation @
( Cancel )

16. Check that the Observation Plot and Observation List views
match what you would expect, e.g. for the filtering operation above:
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[ Observation Plot | Mean Plot ~ Observation List ~ Mean List

Light Curve for Ix_cyg_2439800_2447500.csv
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'Ix_cyg_2439800_2447500.csv' loaded.

17. Repeat similar operations with different 5-star files.

18. Open the Preferences dialog and change the color of the Filtered series,

ensuring that the Observation Plot view updates accordingly after

clicking the Apply or OK buttons. The following shows an example
Preferences setting change for the Filtered series.




8.N.60 Preferences

[ Series Colors Star Groups

Series Description

| Filtered ﬂ

Color

[ swatches = HSB  RGB

Recent:

Preview

= | - [l Sample Text Sample Text .
. . . Sample Text Sample Text

I Y ‘/_\
Set Default Colors Apply
‘/—\
Cancel &—0K—9

19. Negate the filter by selecting No Filter from the View menu.

20. Right-click (or ctrl-click on Mac OS X ...) on the Observation Plot and
select Auto Range P Both Axes (or zoom out if you prefer) to see all the

data points.

21. Select Date Compensated DFT..fromthe Period Search sub-menu
of the Anaysis menu.

22. Accept the default parameters in the dialog box that opens by clicking OK.

23.From the Top Hits tab of the resulting dialog box, select the row with the
highest power value, like this:



8006

Period Analysis (DC DFT) for Ix_cyg_2439800_2447500.csv

f Amplitude vs Frequency = Power vs Frequency = Amplitude vs Period Data = Top Hits J
Frequency Period Power Amplitude
0.0000 21276.5957 9.5846 1.6199
0.0020 492.3683 128.7677 1.5121
0.0021 477.7831 113.2957 1.4816
0.0020 500.0000 78.2756 1.1738
0.0021 470.8098 58.1128 1.0540
0.0007 1499.2504 48.8312 0.9798
0.0007 1432.6648 53.8909 0.9674
0.0048 208.7683 36.9593 0.8117
0.0007 1371.7421 40.5258 0.8000
0.0048 207.4258 32.2801 0.7564
0.0048 210.1282 30.3059 0.7322
0.0041 241.6043 30.1366 0.7138
0.0020 507.8720 28.9142 0.7088
0.0042 239.8082 27.4835 0.6932
0.0006 1572.3270 24.6897 0.6885
0.0022 464.0371 22.8508 0.6682
0.0001 12820.5128 8.4683 0.6588
0.0049 206.1006 21.4104 0.6226
0.0008 1315.7895 23.1826 0.6190
(" New Phase Plot Dismiss )

24. Notice that before selecting this row, the New Phase Plot button was
disabled. Now that it is enabled, click that button. Accept the period and
epoch values in the Phase Plot dialog box that opens next by clicking OK.

25. Dismissing the period analysis dialog box, you should see a phase plot like

this:
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[ Observation Plot | Mean Plot  Observation List  Mean List |
Phase Plot for Ix_cyg_2439800_2447500.csv
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26. The Mean Plot view should look like this:
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Phase Plot with Means for Ix_cyg_2439800_2447500.csv
period: 484.9661, epoch: 2443657.107
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27.Select the Raw View and Phase Plot buttons in the toolbar to switch
between analysis modes.

28. Try opening observation detail dialogs for selected phase plot view data
points.

29. Quit VStar either via the menu item or by closing the window itself.



Scenario

Scenario

Scenario

Scenario

Scenario

Scenario

: Saving and Printing

: Loading from the AAVSO International Database

: Polynomial Fit

: Response to Erroneous Input

: Installing and Using an Observation Source Plug-in

: Star Group Management



